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1. Introduction

This document serves as CHART Intranet and Internet Mapping Application’s System Administrator’s manual. This document discusses the system configuration parameters for the CHART Intranet and Internet Mapping Application.
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4. Mapping Web Application Configuration

Both the Intranet and Internet mapping application uses a XML file to configure the application’s settings. The file resides in the root folder of the web site. Technically system administrator may change attributes, add or delete nodes using any text editor. In reality, modifying the settings may impact the application behaviors or even stops the application from functioning. So be very careful when editing these settings. Always make backups of the file before making any modifications.

After modifying the xml file, administrator should restart IIS to make the change into effect.  To do so, go to Settings->Control Panel->Administrative Tools->Services, select “IIS Admin” service, and click on the “Restart Service” button.  

When prompted, click “Yes” button. The IIS service will be restarted.



4.1 Intranet Mapping Configuration

4.1.1 <CHARTConfig> Node
This node has following attributes that may be modified by administrator:

· CHARTWebDBConnectionString – A valid ADO.Net SQL data connection string specifying the CHARTWeb database server, database name, user name and password to access the database.  The format is:
” Data Source=[DBServer Name];Initial Catalog=[CHARTWeb database name];User ID=[User ID];Password=[Password];Persist Security Info=True ”

· CHARTDBConnectionString – A valid ADO.Net SQL data connection string specifying the CHART II database server, database name, user name and password to access the database.  The format is:
" Provider=[CHART II database name];Password=[Password];User ID=[User ID];Data Source=[DBServer Name] "

· CHARTBackGroundDBConnectionString – A valid ADO.Net SQL data connection string specifying the CHART background layers database server, database name, user name and password to access the database.  The format is:
" Data Source=[DBServer Name];Initial Catalog=[CHARTBG database name];User ID=[User ID];Password=[Password];Persist Security Info=True "

4.1.2 <SDEConnections> Node and <SDEConnection> Node

<SDEConnections> node consists of two <SDEConnections> nodes that specify attributes to connect to CHARTWeb and CHARTBG SDE databases. 

<SDEConnection> node contains the following attributes:

· Name: the name for application to internally referencing the node.  Should be “CHARTWeb” or “CHARTBG”.  Do not change to other names. 

· Sequence: an integer specified by administrator.  It should be different for the two <SDEConnection> nodes.  For instance, “1” and “2”.

· Server: a string with the format of "sde81:”, followed by database server IP.  For instance, “sde81:170.93.51.73".

· User: the user name to access the database 

· Password: the user password to access the database 

· Database: a string with the format of "instance=port:5151;database=”, followed by CHARTWeb database name.  For instance, "instance=port:5151;database=CHARTWeb”. 
4.1.3 
4.1.4 
4.1.5 
4.1.6 <EORSConfig> Node
This node has following attributes that may be modified by administrator:

· CCTVURL – the “Which way camera is facing” page URL when user clicks on a CCTV device.  Current setting is: "http://170.93.51.9/TravInfo/cameraPopUp.asp" 

· ScanCastURL - the scan cast page URL for RWIS devices.  Current setting is: 
"http://170.93.51.19/SCANWeb/ScanCast/SCCFrame.asp?Units=English" 

· CameraURL – the camera image page URL when user clicks on a camera device.  Current setting is:
"http://170.93.51.19/scanweb/Camera.asp?Pageid=Camera&amp;Units=English&amp;Groupid=&amp;Sysid=551&amp;Rpuid=<rpu>&amp;Senid=0&amp;Mapid=&amp;DisplayClass=Java&amp;SenType=All"

· RWISSiteStatusURL – the RWIS site statue page URL.  Current setting is:
"http://170.93.51.19/scanweb/swframe.asp?Pageid=RPUStatus&amp;Units=English&amp;Groupid=551001&amp;DisplayClass=Java&amp;SenType=All"  

· EORSDBConnectionString – a valid ADO.Net SQL data connection string specifying EORS database server, database name, user name and password used to access database.  The format is:
" Data Source=[DBServer Name];Initial Catalog=[EORS database name];User ID=[User ID];Password=[Password];Persist Security Info=True "
4.1.7 <WebSiteConfig> Node
This node has following attributes that may be modified by administrator:


· 
· 
· DefaultIdentifyTolerance – the tolerance as a fraction of current extent.  Default setting is “0.01”.

· LayerAXLCacheInSeconds – an integer specifying how many seconds the application caches the device layer data.  Default setting is 10 seconds. 

The cache can improve application performance during heavy traffic time.  Note that application users can always choose to get the latest data by click “Refresh” button or by turning off and then turning on a layer.  

4.1.8 <MainMapService> Node

This node has following attributes that may be modified by administrator:


· Server – the map server IP address or name.

· ExternalServerName – the external IP address of map server for access from outside of CHART LAN.

4.1.9 <Themes> Node and <Theme> Node
<Themes> node consists of multiple <Theme> sub-nodes. <Theme> node has following attributes that may be modified by administrator:  

· Sequence – the order in which the administrator wants the themes to show on tab

· 
· Caption – the theme label to show on tab

· CHARTUserUpdateInterval – the time interval at which the theme layers are refreshed for CHART logged-in users.  Current setting is “10” (seconds).

· UpdateInterval – the time interval at which scheduled theme layers are refreshed for regular users.  Current setting is “60” (seconds).

4.1.10 <CHARTLayer> Node
Each <Theme> node consists of multiple <CHARTLayer> nodes.  <CHARTLayer> node has following attributes that may be modified by administrator:
· Sequence – the order in which the layer shows under the theme node at legend panel.
· Caption – the layer label
· Visible – whether the layer should be turned on when user click on the theme tab where the layer belongs.  Currently only certain layers under “EORS” theme are set to “false”.

· NeedOffset – whether to offset devices on this layer.  Currently only TSS, DMS, and SHAZAM are set to “true”.

· OnImage – whether the layer is represented by image rather than VML on map.  Currently all four road closure segment layers and winter storm layers are set to “true”.

· LegendIcon – the image icon file name for the layer if layer is represented by a single symbol.  When layer is not represented by a single symbol, the attribute value should be “”.

4.1.11 <MapLegendEntry> Node
If a layer is represented by multiple symbols, then the <CHARTLayer> node should include multiple <MapLegendEntry> nodes.  Each <MapLegendEntry> node has following attributes:
· Sequence – the order in which the legend entry shows under the layer

· Caption – the legend entry text 

· ImageFile – the image file name for the legend icon.

4.1.12 <MapExtentCategories> Node and <MapExtentCategory> Node
<MapExtentCategories> node consists of multiple <MapExtentCategory> nodes.  <MapExtentCategory> node has a “Name” attribute.
  The possible values are “Region”, “County”, “District”, or "Op. Ctr".   Each <MapExtentCategory> node may contain multiple <MapExtent> sub-nodes.
4.1.13 <MapExtent> Node
Each <MapExtent> node contains the following attributes:
· 
· Caption – the extent name that is displayed in the “View” menu.
· Left – the x coordinate of the top-left corner

· Top – the x coordinate of the top-left corner

· Bottom – the x coordinate of the bottom-right corner
· Right – the x coordinate of the bottom-right corner
4.1.14  <UserGroups> Node and <UserGroup> Node
<UserGroups> node consists of multiple <UserGroup> sub-nodes.  <UserGroup> has following attributes:

· Name – the user group name for application’s internal reference
· Right, Left, Top, Bottom – the coordinates of the default map extent for the group
4.2 Internet Mapping Configuration

4.2.1 
The following sections describe the nodes for Internet Mapping Application settings that may be modified by system administrator.  

4.2.2 <CHARTConfig> Node
<CHARTConfig> node has following attributes that may be modified by administrator:
· CHARTDBConnectionString – A valid ADO.Net SQL data connection string specifying the CHARTWeb database server, database name, user name and password to access the database.  The format is:
” Data Source=[DBServer Name];Initial Catalog=[CHARTWeb database name];User ID=[User ID];Password=[Password];Persist Security Info=True ”

· CHARTWebServerURL – the CHART web server name.  Default setting is "http://soc-web-svr02/"

· CHARTBackGroundDBConnectionString – A valid ADO.Net SQL data connection string specifying the CHART background layers database server, database name, user name and password to access the database.  The format is:
" Data Source=[DBServer Name];Initial Catalog=[CHARTBG database name];User ID=[User ID];Password=[Password];Persist Security Info=True "
4.2.3 <SDEConnections> Node

<SDEConnections> node consists of two <SDEConnections> nodes that specify attributes to connect to CHARTWeb and CHARTBG SDE databases. <SDEConnection> node has the following attributes:
· Name: the name for application to internally referencing the node.  Should be “CHARTWeb” or “CHARTBG”.  Do not change to other names. 
· Sequence: an integer specified by administrator.  It should be different for the two <SDEConnection> nodes.  For instance, “1” and “2”.
· Server: a string with the format of "sde81:”, followed by database server IP.  For instance, “sde81:SOC-BLADE-1".
· User: the user name to access the database 

· Password: the user password to access the database 

· Database: a string with the format of "instance=port:5151;database=”, followed by CHARTWeb database name.  For instance, "instance=port:5151;database=CHARTWeb”. 
4.2.4 
4.2.5 <WebSiteConfig> Node
This node has following attributes that may be modified by administrator:

· DefaultTool – the default tool button on toolbar.  Default setting is  “ ZoomIn”.  
· DefaultTheme – the default theme to turn on when loading the application.  Default setting is “Traffic”.  
· DefaultIdentifyTolerance – the tolerance as a fraction of current extent.  Default setting is “0.005”.

4.2.6 <MainMapService> Node and <OverviewMapService> Node
Both nodes have the following attributes:

· Server –the map server IP address or name.

· Service – the ArcIMS service name
· 
4.2.7 <Themes> Node and <Theme> Node
<Themes> node consists of multiple <Theme> sub-nodes that specify the theme names, the layers under each theme, and settings of layers.  <Theme> node has following attributes that may be modified by administrator:
· Sequence – the order in which the themes show on tab

· 
· Caption – the theme label to be displayed on tab

4.2.8 <MapExtentCategories> Node and <MapExtentCategory> Node
<MapExtentCategories> node consists of multiple <MapExtentCategory> nodes <MapExtentCategory> Node.  <MapExtentCategory> node has a “Name” attribute.  The possible values are “Region”, “State”, “Metropolitan”, or “County”.   Each <MapExtentCategory> node may contain multiple <MapExtent> sub-nodes.
4.2.9 <MapExtent> Node 

Each <MapExtent> node contains the following attributes:

· 
· Caption – the extent name that is displayed in the “View” dropdown list.

· Left – the x coordinate of the top-left corner

· Top – the x coordinate of the top-left corner

· Bottom – the x coordinate of the bottom-right corner

· Right – the x coordinate of the bottom-right corner
4.2.10 
4.2.11 
4.2.12 <UserGroups> Node and <UserGroup> Node

4.2.13 <UserGroups> node consists of multiple <UserGroup> sub-nodes.  <UserGroup> has following attributes:

· Name – the user group name for application’s internal reference

· Right, Left, Top, Bottom – the coordinates of the default map extent for the group
4.3 Configuring Web.Config File for Exception Handling Notification
From the root folder of the web mapping application, open Web.Config in a text editor.

  Under <exceptionManagement> section:

1. Set the first <publisher> node’s mode attribute to “on”.

2. Set the first <publisher> node’s ToEmail attribute to the email address of the person to receive exception notification emails.

3. Set the first <publisher> node’s SMTPServer attribute to the SMTP server (currently 170.93.42.133).
· 
· 
4.4 


5. Intranet Mapping Application Programming Interface 

5.1 
Here following is a list of the parameters that will be available to external systems:

	Case ID
	Parameter Name 
	Possible Values
	Additional Parameters
	Description

	1
	usr
	<text>
	
	CHART user ID

	2
	pwd
	<text>
	
	CHART password

	3
	opctr
	<text>
	
	Operation center ID

	4
	cmd
	ViewEvents
	
	Open map view with all event listed

	5
	
	
	Filter=UnMapped/Mapped/All


	Open map view with list of events filtered to mapped or unmapped events or all events

	6
	
	
	OpCenter=xxxx
	Filter events to only the ones for the specified operation center.

	7
	
	LocateEvent
	EventID=xxxx
	Open map view, display the locate event UI.  Zoom to the county of the event.  If the event description provide enough information to geocode the event, center on the geocoded location.  If the geocode provide several candidate locations, display them on the locate event UI.

	8
	
	LocateClosure
	Type=construction/weather/pending/Planned&permit=xxxx&eorssvr=xxx.xxx.xxx.xxx
	Assign closure geometry.  System will query the road closure record in EORS to zoom to the county, road of the closure.  System will display “Locate Closure” interface.

	9
	theme
	Theme name
	
	Initialize map to the specified theme.

	10
	zoom
	Rect
	L=x&R=x&T=x&B=x
	Zoom to map with extent specified by left, right, bottom, top ranges specified in MD State Plane coordinates.

	
	
	
	L=x&R=x&T=x&B=x&coordsys=geo
	

	11
	
	OpCenter
	OCID=xxxx
	Zoom to default map extent of the operation center.

	12
	
	IntSect
	St1=MD-32&St2=I-95&Extent=n
	Center on intersection of street 1 and street 2.  If more than one candidate is found, show a list for user’s selection.  Set map extent to n miles

	13
	
	RtMile
	Rt=I-95&Mile=2&Extent=n
	Center on the specified route and mile marker.  Set map extent to n miles

	14
	
	County
	County=FIPSX, where X is county Fips.
	Zoom to a county

	15
	
	District
	Dist=xxxx
	Zoom to a district

	16
	
	PreDefined
	ExtName=xxxx
	Zoom to a pre-defined map extent named xxxx

	17
	
	Device
	Type=xxx&ID=xxxx&Extent=n
	Zoom to the specified device, with map extent of n miles.  If n is omitted extent will be set to 5 miles.

	18
	
	Event
	ID=xxxx&Extent=n
	Zoom to the specified device, with map extent of n miles.  If n is omitted extent will be set to 5 miles.

	19
	
	EORSClosure
	Permit=xxxx&Extent=n
	Center on the specified closure with map extent of the larger of closure extent of closure or n miles.  If n is omitted, extent will be set to 5 miles.


· All of the parameters are optional.  If they are omitted, the system will assume the default web site configuration setting.
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